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Important Information

Warranty

Copyright

Trademarks

The GPIB-PCII/ITA hardware is warranted against defects in materials and workmanship for a period of two years from
the date of shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair
or replace equipment that proves to be defective during the warranty period. This warranty includes parts and labor.

The media on which you receive National Instruments software are warranted not to fail to execute programming
instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evidenced
by receipts or other documentation. National Instruments will, at its option, repair or replace software media that do
not execute programming instructions if National Instruments receives notice of such defects during the warranty
period. National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside
of the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping
costs of returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this manual is accurate. The document has been carefully
reviewed for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves
the right to make changes to subsequent editions of this document without prior notice to holders of this edition. The
reader should consult National Instruments if errors are suspected. In no event shall National Instruments be liable for
any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND
SPECIFICALLY DISCLAIMS ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL
INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS
WILL NOT BE LIABLE FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR
CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability of National
Instruments will apply regardless of the form of action, whether in contract or tort, including negligence. Any action
against National Instruments must be brought within one year after the cause of action accrues. National Instruments
shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty provided
herein does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to follow the
National Instruments installation, operation, or maintenance instructions; owner’s modification of the product;
owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties,
or other events outside reasonable control.

Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical,
including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part,
without the prior written consent of National Instruments Corporation.

CVI™, LabVIEW™, NAT4882™, natinst.com™, NI-488™, NI-488.2™, and NI-488.2M™ are trademarks of National
Instruments Corporation.

Product and company names listed are trademarks or trade names of their respective companies.

WARNING REGARDING MEDICAL AND CLINICAL USE OF NATIONAL INSTRUMENTS PRODUCTS

National Instruments products are not designed with components and testing intended to ensure a level of reliability
suitable for use in treatment and diagnosis of humans. Applications of National Instruments products involving
medical or clinical treatment can create a potential for accidental injury caused by product failure, or by errors on the
part of the user or application designer. Any use or application of National Instruments products for or involving
medical or clinical treatment must be performed by properly trained and qualified medical personnel, and all traditional
medical safeguards, equipment, and procedures that are appropriate in the particular situation to prevent serious injury
or death should always continue to be used when National Instruments products are being used. National Instruments
products are NOT intended to be a substitute for any form of established process, procedure, or equipment used to
monitor or safeguard human health and safety in medical or clinical treatment.



FCC/DOC Radio Frequency Interference
Class B Compliance

This equipment generates and uses radio frequency energy and, if not installed and used in strict
accordance with the instructions in this manual, may cause interference to radio and television
reception. Classification requirements are the same for the Federal Communications Commission
(FCC) and the Canadian Department of Communications (DOC). This equipment has been tested and
found to comply with the following two regulatory agencies:

Federal Communications Commission

This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no guarantee that interference will not occur
in a particular installation. If this equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try
to correct the interference by one or more of the following measures:

¢ Reorient or relocate the receiving antenna.
* Increase the separation between the equipment and receiver.

¢ Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

« Consult the dealer or an experienced radio/TV technician for help.

Notices to User: Changes or modifications not expressly approved by National Instruments could void
the user’s authority to operate the equipment under the FCC Rules.

This device complies with the FCC rules only if used with shielded interface cables of
suitable quality and construction. National Instruments used such cables to test this
device and provides them for sale to the user. The use of inferior or nonshielded
interface cables could void the user’s authority to operate the equipment under the
FCC rules.

If necessary, consult National Instruments or an experienced radio/television technician for additional
suggestions. The following booklet prepared by the FCC may also be helpful: Interference to Home
Electronic Entertainment Equipment Handbook. This booklet is available from the U.S. Government
Printing Office, Washington, DC 20402.

Canadian Department of Communications

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment
Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Reglement sur le matériel
brouilleur du Canada.
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About
This
Manual

This manual contains instructions to help you install and configure the
National Instruments GPIB-PCII/IIA interface board and the GPIB
software.

How to Use the Manual Set

Installation and
Configuration

Getting Started
Manual

.

Novice Experienced
Users Users
=N =N
GPIB User NI-488.2M Function
Manual for Reference Manual
Application Function
Development and Routine
and Examples Descriptions

Use this getting started manual to install and configure your
GPIB-PCII/IIA and the GPIB software.

Use the GPIB User Manual for Win32 to learn the basics of GPIB and
how to develop an application program. The user manual also contains
debugging information and detailed examples.
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About This Manual

Use the NI-488.2M Function Reference Manual for Win32 for specific
NI-488 function and NI-488.2 routine information, such as format,
parameters, and possible errors.

Organization of This Manual

This manual is organized as follows:

GPIB-PCII/IIA for Windows 98/95

Chapter 1, Introduction, explains how to use this manual, lists what
you need to get started and optional equipment you can order, and
briefly describes the GPIB-PCII/IIA and the GPIB software.

Chapter 2, Installation and Configuration, describes how to install
and configure the GPIB-PCII/ITA and the GPIB software.

Chapter 3, Verify the Installation, describes how to verify the
hardware and software installation.

Chapter 4, Begin to Use the GPIB Software, helps you get started
with the GPIB software.

Appendix A, Uninstalling the Hardware and Software, describes
how to uninstall your GPIB-PCII/ITA and the GPIB software.

Appendix B, Using the GPIB-PCII/IIA in GPIB-PCIIA Mode,
describes potential problems with using the GPIB-PCII/IIA in
GPIB-PCIIA mode and contains instructions for configuring the
GPIB-PCIV/IIA in GPIB-PCIIA mode.

Appendix C, Troubleshooting and Common Questions, describes
how to troubleshoot problems and answers some common
questions.

Appendix D, Specifications, describes the physical characteristics

of the GPIB-PCII/IIA, the transfer rate of the GPIB software, and
the recommended operating conditions.

Appendix E, Customer Communication, contains forms you can
use to request help from National Instruments or to comment on our
products and manuals.

The Glossary contains an alphabetical list and a description of
terms used in this manual, including abbreviations, acronyms,
metric prefixes, mnemonics, and symbols.
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About This Manual

Conventions Used in This Manual

»

N

bold

bold italic

bold monospace

IEEE 488 and
IEEE 488.2

italic
italic monospace

monospace

The following conventions are used in this manual:

The » symbol leads you through nested menu items and dialog box
options to a final action. The sequence File»Page Setup»Options»
Substitute Fonts directs you to pull down the File menu, select the
Page Setup item, select Options, and finally select the Substitute Fonts
option from the last dialog box.

This icon to the left of bold italicized text denotes a note, which alerts
you to important information.

This icon to the left of bold italicized text denotes a caution, which
advises you of precautions to take to avoid injury, data loss, or a
system crash.

Bold text denotes the names of menus, menu items, dialog boxes, dialog
box buttons or options, icons, windows, or Windows tabs.

Bold italic text denotes a note or caution.

Bold text in this font denotes the messages and responses that the
computer automatically prints to the screen.

IEEE 488 and IEEE 488.2 refer to the ANSI/IEEE Standard 488.1-1987
and the ANSI/IEEE Standard 488.2-1992, respectively, which define
the GPIB.

Italic text denotes disk names, emphasis, a cross reference, or an
introduction to a key concept.

Italic text in this font denotes that you must supply the appropriate
words or values in the place of these items.

Text in this font denotes text or characters that you should literally enter
from the keyboard, sections of code, programming examples, and
syntax examples. This font is also used for the proper names of disk
drives, paths, directories, programs, subprograms, subroutines, device
names, functions, operations, variables, filenames and extensions, and
for statements and comments taken from programs.

© National Instruments Corporation Xi GPIB-PCII/IIA for Windows 98/95



About This Manual

Related Documentation

The following documents contain information that you may find helpful
as you read this manual:

e ANSVIEEE Standard 488.1-1987, IEEE Standard Digital Interface
for Programmable Instrumentation

¢ ANSI/IEEE Standard 488.2-1992, IEEE Standard Codes, Formats,
Protocols, and Common Commands

e LabVIEW Function and VI Overview Manual
e LabVIEW User Manual

*  LabWindows/CVI Standard Libraries Reference Manual
*  LabWindows/CVI User Manual

e  Microsoft Windows Online Help, Microsoft Corporation

Customer Communication

National Instruments wants to receive your comments on our products
and manuals. We are interested in the applications you develop with
our products, and we want to help if you have problems with them.
To make it easy for you to contact us, this manual contains comment
and configuration forms for you to complete. These forms are in
Appendix E, Customer Communication, at the end of this manual.
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Introduction

Chapter

This chapter explains how to use this manual, lists what you need to get
started and optional equipment you can order, and briefly describes the

GPIB-PCII/ITA and the GPIB software.

How to Use This Manual

Gather What You Need
Chapter 1
P C to Get Started )

v

| Install the Software

\4
Chapter 2 | Install the Hardware

v

| Configure the Software

v

| Verify the Installation

¢
Chapter 3
No
+ Yes
Run Interactive Control Utility I
Chapter 4 +
Review Programming
Considerations
User Manual and v
Function Reference C Write Application Program )
Manual

Troubleshooting
Appendix
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Chapter 1 Introduction

What You Need to Get Started

Make sure you have all of the following items before you attempt to install
the hardware and software.

[1  Windows 95 or later installed on your computer

[J GPIB-PCII/IIA interface board

[l GPIB Software for Windows NT/98/95 CD, which comes in your kit
U

GPIB cables—single shielded or double-shielded, Type X1, X2, or X5,
which you can order from National Instruments

Note If you do not have a CD drive and would like to order the GPIB software on
Sfloppy disks, contact National Instruments and order part number 777780-01.

Optional Equipment

Call National Instruments for more information about the following
optional equipment:

e Serial or parallel bus extender and cables
e Bus expander/isolator

¢  GPIB mechanical switch

GPIB-PCII/IIA Hardware Overview

The GPIB-PCII/IIA interface board combines the functionality of the
National Instruments GPIB-PCII and GPIB-PCIIA interface boards. It can
be configured to function in either GPIB-PCII mode or GPIB-PCIIA mode,
depending on the setting of the configuration switches.

The GPIB-PCII/ITA board, equipped with the NAT4882 ASIC, transforms
any IBM PC, PC/XT, PC AT, or compatible computer into a
full-functioning IEEE 488.2 Talker/Listener/Controller. The NAT4882
controller chip is fully compatible with the IEEE 488.2 standard.
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Chapter 1 Introduction

You can use standard GPIB cables to connect the GPIB-PCII/ITA with up
to 14 instruments. If you want to use more instruments, you can order a bus
extender or expander from National Instruments. Refer to Appendix D,
Specifications, for more information about the GPIB-PCII/IIA hardware
specifications and recommended operating conditions.

GPIB Software Overview

The GPIB software includes a native, 32-bit multitasking driver that is fully
Plug and Play aware. Because the GPIB-PCII/IIA is not a Plug and Play
board, Windows is unable to detect its addition to or removal from your
system dynamically. You must manually inform Windows about the
insertion or removal of the GPIB-PCII/IIA from your system. This manual
fully describes the insertion and removal procedures for the GPIB-PCII/ITA
hardware.

The GPIB software for Windows supports the concurrent use of multiple
types of GPIB hardware. For example, you can communicate with GPIB
devices through both a GPIB-PCII/ITA and an AT-GPIB/TNT in the same
system at the same time. The GPIB software is fully integrated into the
Windows operating system. It is configurable through the System applet
and uninstallable through the Add/Remove Programs applet of the Control
Panel.

The GPIB software, along with the GPIB-PCII/ITA, transforms a
general-purpose PC into a GPIB Talker/Listener/Controller with complete
communications and bus management capability. The GPIB software
includes the following components:

*  Device driver

*  Diagnostic test utility

*  Configuration utility

e Interactive control program

»  Utilities for software development

* Language interface libraries for Microsoft Visual C/C++ 2.0 or later,
Borland C/C++ 4.0 or later, and Microsoft Visual Basic 4.0 or later

*  Sample applications that use NI-488 functions and NI-488.2 routines

Refer to Appendix D, Specifications, for information about the GPIB
software transfer rates.
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Chapter 1 Introduction

Time-Saving Development Tools

Your kit includes the GPIB software. In addition, you can order the
LabWindows/CVI or LabVIEW software from National Instruments to
speed your application development time and make it easier to
communicate with your instruments.

LabVIEW is an easy-to-use, graphical programming environment you can
use to acquire data from thousands of different instruments, including IEEE
488.2 devices, VXI devices, serial devices, PLCs, and plug-in data
acquisition boards. After you have acquired raw data, you can convert it
into meaningful results using the powerful data analysis routines in
LabVIEW. LabVIEW also comes with hundreds of instrument drivers,
which dramatically reduce software development time, because you do not
have to spend time programming the low-level control of each instrument.

LabWindows/CVI is similar to LabVIEW, except that it combines an
interactive, easy-to-use development approach with the programming
power and flexibility of compiled ANSI C code.

The GPIB Analyzer is another optional tool available from National
Instruments that is useful in troubleshooting a variety of IEEE 488
hardware and software problems. With its built-in time-stamping
capability, you can easily determine the throughput and overhead of your
GPIB system. The GPIB Analyzer software can be used with the
AT-GPIB/TNT+ and PCMCIA-GPIB+ GPIB hardware, which provide
GPIB Analyzer support along with the functionality of a high-performance
GPIB Controller.

For ordering information, or to request free demonstration software,
contact National Instruments.
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Installation and
Configuration

This chapter describes how to install and configure the GPIB-PCII/IIA
and the GPIB software.

Install the GPIB Software

Before installing the hardware, complete the following steps to install
the GPIB software.

1. Insert the CD GPIB Software for Windows NT/98/95. The CD
autoplay feature automatically launches the setup wizard.

The setup wizard guides you through the necessary steps to install
the GPIB software. You can go back and change values where
appropriate by clicking on the Back button. You can exit the setup
if necessary by clicking on the Cancel button.

Note If you do not have a CD drive and would like to order the GPIB software on
floppy disks, contact National Instruments and order part number 777780-01.

2.  When the setup is complete, restart Windows.

Proceed to the next section, Install the Hardware.

Install the Hardware

This section describes how to install your GPIB-PCII/ITA board under
Windows.

Remove System-Reserved Resources

If you have previously installed the GPIB Compatibility Release for
Windows 98/95, you should remove any system-reserved resources
for your GPIB-PCII/ITA. Refer to the Removing System-Reserved
Resources section in Appendix C, Troubleshooting and Common
Questions.
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System-reserved resources are only acquired manually. If you did not
use the Device Manager to acquire system-reserved resources, you do
not need to use the Device Manager to remove such resources.

Identify Resources for the GPIB-PCII/IIA

Before installing the GPIB-PCII/ITA, use the Add New Hardware
Wizard to inform Windows about the new hardware you are about to
install in your system.

1.
2.

GPIB-PCII/IIA for Windows 98/95

Select Start»Settings»Control Panel.

Launch the Add New Hardware Wizard by double-clicking on the
Add New Hardware icon.

Click on the Next button in the first Add New Hardware Wizard
dialog box.

Because the GPIB-PCII/IIA is not a Plug and Play interface,
Windows is unable to detect its presence automatically.

Windows 95:

When the next Add New Hardware Wizard dialog box offers to
detect new hardware, check No instead of Yes (Recommended),
then click on the Next button to continue.

Windows 98:

a. Click on the Next button in the next Add New Hardware
Wizard dialog box.

b. In the next dialog box, check No, the device isn’t in the list,
then click on the Next button to continue.

c. Inthe next dialog box, check No, I want to select the hardware
from a list, then click on the Next button to continue.

The next Add New Hardware Wizard dialog box lets you select the
type of hardware you want to install. Select the Other Devices item,
as shown in Figure 2-1. You may select the National Instruments
GPIB Interfaces item instead, if it appears in the dialog box. Click
on the Next button to continue.
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Add New Hardware Wizard

Select the type of hardware you want to install

Hardware types:

"= Hard disk contrallers =l
@ Keyboard

v@ Memary Technalogy Drivers [MTDs]

@ Madem

E@ Mouse

W National Instruments GPIE Interfaces

= Network adaptels

ey PEMEI:& snckel
¥ Ports [COM & LFT) =

< Back I Meut » I Cancel |

Figure 2-1. Add New Hardware Wizard Hardware Selection

6. The next Add New Hardware Wizard dialog box lets you select the
manufacturer and model of your hardware. Select National
Instruments as the manufacturer.

7. Decide whether you will use the GPIB-PCII/ITA in GPIB-PCII
mode or GPIB-PCITA mode. Both modes have the same
capabilities, but the two modes use different regions of I/O space.

5 Note National Instruments recommends that you use GPIB-PCII mode.

For an explanation of why GPIB-PCIIA mode is not recommended,
read the Problems Using the GPIB-PCII/IIA in GPIB-PCIIA
Mode section in Appendix B, Using the GPIB-PCII/IIA in
GPIB-PCIIA Mode.

8. Select the model of your hardware, either GPIB-PCII or
GPIB-PCIIA, and click on the Next button to continue. Windows
attempts to assign nonconflicting resources to the GPIB-PCII/ITA.

If Windows is able to assign resources successfully, the next
Add New Hardware Wizard dialog box describes the resources
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assigned to the GPIB-PCII/IIA, as shown in the example dialog box
in Figure 2-2. Skip to Step 9 to proceed.

Add Hew Hardware Wizard
w Wwindows can install your hardware, using the follawing settings.

WARNING: Your hardware may hot be set to uze the resources listed. [F you
need to, you can adjust these settings by using the Device Manager in the
System control panel before restarting your computer. To change your
hardware settings. e the documentation that cane with your hardware.

Ta continue inztalling the software needed by your hardware, click Nest.

Rezource type Setting Frrint....

Direct Memony Access 01
Input/Output Range  02B8 - 02BF
Interrupt Request o7

< Back | MHext » | Cancel

Figure 2-2. GPIB-PCII/IIA Resources Assigned Successfully

If Windows is unable to assign resources successfully, the next Add
New Hardware Wizard dialog box explains the problem, as shown
in Figure 2-3.

Add New Hardware Wizard

Y'ou are uging other hardware that conflictz with the
hardware you are trving to install,

You have two choices: You can continue ar ext.

To continue instaling the software, click Next, The
hardware will not work properly untl pou rezolve the
conflict, IF you choose to continue, Windows will provide a
troubleshooting tool bo help you resclve the conflict when
wou finigh the wizard,

To exit without ingtalling the software, click Cancel.

< Back Cancel

Figure 2-3. GPIB-PCII/IIA Resources Not Assigned Successfully
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If this dialog box appears, click on the Next button to continue, then
click on Start Conflict Troubleshooter to let Windows help you
determine how to resolve the conflicts that are preventing it from
assigning resources. Follow the steps recommended by the Conflict

Troubleshooter help.

When you reach the step of looking for nonconflicting resources
for the GPIB-PCII/ITA, you need to change the Setting based on
selection on the Resources tab of the GPIB-PCII/IIA Properties
dialog box. Figure 2-4 shows the Resources tab for a

GPIB-PCII/IIA in GPIB-PCII mode.

GPIB-PCII Properties

General] GFIB Settings  Resources ]

w GPIB-PCII

Besource settings:

Resource type Setting

~ |nput/Output Fangs EEOEIEGER
- Interrupt Request 02

i Direct Memomny Accezs 03

Setting based on:

B azic configuration 1
Change Settingl B asic configuration 2
Bazic configuration 3

Conflicting device list:

Interupt Request 02 used by: J
Frogrammable interrupt contraller

ak. | Cancel |

Figure 2-4. GPIB-PCII/lIIA Resources Settings
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Continue following the instructions provided by the Conflict
Troubleshooter to resolve the conflicts.

9. Write down the conflict-free resources that Windows assigned to
the GPIB-PCII/IIA.

10. Shut down Windows.

Configure the GPIB-PCII/IIA in GPIB-PCIl Mode

Note If you are using the GPIB-PCII/IIA in GPIB-PCIIA mode, refer to the
Configure the GPIB-PCII/IIA in GPIB-PCIIA Mode section in Appendix B,
Using the GPIB-PCII/IIA in GPIB-PCIIA Mode, for instructions on how to
configure the hardware.

A Caution  Electrostatic discharge can damage several components on the
GPIB-PCII/IIA. To avoid such damage in handling the board, touch the
antistatic plastic package to a metal part of your computer chassis before
removing the board from the package.

Verify GPIB-PCIl Mode

Make sure that your GPIB-PCII/ITA is configured for GPIB-PCII mode.
Examine switch 9 in switch block U2. Refer to Figure 2-5 to find switch
block U2.
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1 Product Name 3 Base I/O Address 5 DMA Channel
2 Assembly Number, Serial 4 Interrupt Level 6 Shield Ground
Number, and Revision Number

Figure 2-5. GPIB-PCII/IIA Parts Locator Diagram

© National Instruments Corporation 2-7 GPIB-PCII/IIA for Windows 98/95



Chapter 2 Installation and Configuration

Verify that switch 9 is pressed down on the side labeled PCII, as shown
in Figure 2-6.

~

| I—
7210 | [C— Bm 9914
PCII q@ PCIIA
— 7

[ = not used to select the GPIB-PC
or 7210/9914 mode

Figure 2-6. GPIB-PCIl Mode Selection Setting

Verify 7210 Mode

The GPIB-PCII/IIA can emulate IEEE 488 interface boards that use
the 7210 GPIB Controller chip or the 9914 chip. Examine switch 8 in
switch block U2. Verify that switch 8 is pressed down on the side
labeled 7210, as shown in Figure 2-6.

Note The National Instruments GPIB software requires the board to be in
7210 mode.

Configure the Hardware Resources

Configure the GPIB-PCII/ITA jumpers and switches to match the
resources assigned to it by Windows. If the resources assigned to it
match the default settings, you are ready to install the GPIB-PCII/IIA.
The default settings for GPIB-PCII mode are:

e Input/Output Range: 2B8-2BF
e Direct Memory Access: 1

e Interrupt Request: 7
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If the resources match the default settings, proceed to the Install the
GPIB-PCII/IIA section, later in this chapter.

If the resources do not match the default settings, you must reconfigure
the jumpers and switches, as described in the next few sections, to
match the resources assigned to the GPIB-PCII/ITA by Windows.

Configure the Input/Output Range (GPIB-PCII Mode)

An Input/Output Range is a segment of address space reserved for the
input and output of a board. The base I/O address of an Input/Output
Range is the first position in the Input/Output Range used by the plug-in
interface board. By default, the GPIB-PCII/IIA is configured to use
base I/0O address 2B8 hex. With this setting, the board uses an
Input/Output Range of 2B§ hex to 2BF hex.

Follow these steps to reconfigure the base I/O address of the
GPIB-PCII/IIA.

1. Locate the base I/0O address switch at U2 on your GPIB-PCII/ITA
board. Refer to Figure 2-5.

2. Change the switch settings to configure the GPIB-PCII/ITA board
to match the base I/O address of the Input/Output Range assigned
by Windows.

Press down on the side marked 1 to select a binary value of 1 for
the corresponding address bit. Press down on the 0 side of the
switch to select a binary value of 0. Refer to Figure 2-7 for

two examples of the switch settings and corresponding base I/0O
addresses.
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Push this side down (OFF) for logic 1
Push this side down (ON) for logic 0

Binary Hex
0
1 U2 0 0 0
) 0
A3|o - 0
A4 | N 0
A5 @:Iw 0 0
A6 @:IJ> 0
A7 @:I01 0
A8 — $°° 1
3
= ‘
[ee]
PCII qw PCIIA
— 7/
Switches Set to Base 1/0
Address hex 300
Binary Hex
0
1020 0 8
/ ) 0
A3|o = 1
A4|T o 1
AS gw 1 5
A6 & 0
A7 qo‘ 1
A8 o 0 o
A9 ~ 1
[e¢]

PCII $® PCIIA
~—

Switches Set to Default Setting
Address hex 2B8

[ = not used to select the base I/O address

Figure 2-7. Base I/0 Address Switch Settings for GPIB-PCII Mode
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Configure the Interrupt Request (GPIB-PCIl Mode)

PC-compatible computers have a series of interrupt lines available to
devices. Devices use interrupts to get service from the CPU for
asynchronous events. Your GPIB hardware and software use interrupts
to get service from the CPU when necessary. By default, the
GPIB-PCII/IIA is configured to use interrupt request line 7.

5 Note If no interrupt lines are available for your GPIB hardware, the jumper must
be moved to the disabled position, shown in Figure 2-9.

Follow these steps to reconfigure the interrupt request line:

1. Find the jumpers that set the interrupt request line. The jumpers are
located on the lower edge of your GPIB-PCII/ITA. Refer to
Figure 2-5.

2. Change the jumper settings to configure the GPIB-PCII/IIA to
match the interrupt assigned by Windows. Figure 2-8 shows the
setting for IRQ7.

Figure 2-8. GPIB-PCII/IIA Interrupt Jumper Setting for IRQ7 (Default Setting)

Figure 2-9 shows the setting for disabled interrupts.

Figure 2-9. GPIB-PCII/IIA Interrupt Jumper Setting for No Interrupts
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Configure the Direct Memory Access

Direct memory access (DMA) refers to data transfers directly to

or directly from devices such as the GPIB-PCII/IIA and computer
memory. Your GPIB hardware and the GPIB software are designed
to perform DMA. In most cases, data transfers using DMA are
significantly faster than programmed I/O transfers. However, if
Windows is unable to assign a DMA resource to the GPIB-PCII/IIA,
you can configure DMA to none and still use the GPIB software. By
default, the GPIB-PCII/ITA is configured to use DMA channel 1.

Follow these steps to reconfigure the DMA channel:

1. Locate the jumpers that select the DMA channel. Refer to

Figure 2-5.

2. Change the jumper settings to configure the GPIB-PCII/IIA to
match the DMA channel assigned by Windows. You must set both
the DMA Acknowledge and DMA Request lines, as shown in

Table 2-1.

Table 2-1. GPIB-PCII/IIA DMA Channel Settings

Signal Lines

DMA
Channel DMA Acknowledge DMA Request
1 DACK1 DRQI
2 DACK2 DRQ2
3 DACK3 DRQ3
none — —

GPIB-PCII/IIA for Windows 98/95
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Figure 2-10 shows the jumper position for selecting DMA channel 1.

7
é/é/é/é/
2
0 & & &
528888
r OoOoc O ax O
530853

Figure 2-10. GPIB-PCII/IIA DMA Jumper Setting for DMA Channel 1

Figure 2-11 shows the jumper position for selecting no DMA channel.

N

DACK2 N N

N
N

TN
N

N

DRQ1 \§
DACK1 \§

DRQ2

DRQ3
DACK3

Figure 2-11. GPIB-PCII/IIA DMA Jumper Setting for No DMA Channel

Setting the Shield Ground Configuration

The GPIB-PCII/TIA is set at the factory with the jumper in place to
connect the logic ground of the GPIB-PCII/IIA to its shield ground.
This configuration minimizes EMI emissions.

i”i Caution  The GPIB-PCII/IIA was tested for compliance with FCC and CE standards
with the shield ground connected to logic ground. Removing the jumper might
cause EMI emissions to exceed the applicable standards.
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If your application requires that logic ground be disconnected from
shield ground, follow these steps:

1. Refer to Figure 2-5 to locate the shield ground jumper W1 on the
GPIB-PCII/IIA.

2. Remove the jumper and place it across only one of the jumper pins,

as shown in Figure 2-12.
P w

a. Logic Ground Connected to Shield Ground (Default)

D

b. Logic Ground Disconnected from Shield Ground

Figure 2-12. GPIB-PCII/IIA Ground Configuration Jumper Settings

Now that you have properly configured the hardware, continue on to the
Install the GPIB-PCII/IIA section for installation instructions.

Install the GPIB-PCII/IIA
Perform the following steps to install the GPIB-PCII/ITA:

1. Shut down Windows and turn off your computer. Keep the
computer plugged in so that it remains grounded while you install
the GPIB hardware.

2. Remove the top cover (or other access panels) to give yourself
access to the computer expansion slots.

Find an unused expansion slot in your computer.

4. Remove the corresponding slot cover on the back panel of the
computer.

5. Insert the GPIB-PCII/IIA into the slot with the GPIB connector
sticking out of the opening on the back panel, as shown in
Figure 2-13. It might be a tight fit, but do not force the board
into place.
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Figure 2-13. Installing the GPIB-PCII/IIA

6. Screw the mounting bracket of the GPIB-PCII/IIA to the back panel
rail of the computer.

Replace the top cover (or the access port to the expansion slot).

Turn on your computer and start Windows.

The GPIB-PCII/ITA hardware installation is now complete. Proceed to
the next section, Configure the GPIB Software.

Configure the GPIB Software

The GPIB Configuration utility is fully integrated with the Windows
Device Manager. You can use it to examine or modify the configuration
of the GPIB software. The context-sensitive online help, available by
right-clicking on any of the controls on the configuration utility tabs,
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includes all of the information that you need to configure the GPIB
software properly.

To begin to configure the GPIB software, double-click on the System
icon under Start»Settings»Control Panel. In the System Properties
dialog box that appears, select the Device Manager tab, click on the
View devices by type button at the top of the tab, and scroll down to the
National Instruments GPIB Interfaces icon.

Resolve Conflicts

If you have other non Plug and Play hardware in your system, Windows
might assign incorrect resources to your GPIB-PCII/ITA. If this
happens, Windows shows that the GPIB-PCII/IIA is not working, and
you must reconfigure the GPIB-PCII/IIA module and the GPIB
software.

On the Device Manager page, look at the items listed under the
National Instruments GPIB Interfaces icon. If there is no

National Instruments GPIB Interfaces icon or if a circled X or
exclamation point (!) appears through the eagle icon, the
GPIB-PCII/IIA is not working properly. Figure 2-14 shows an example
of a GPIB-PCII/IIA that is working properly, and Figure 2-15 shows an
example of a GPIB-PCII/ITA that is not working properly.

A it :
+ P«j Mouse [
-1-"W Mational Instruments GPIB Interfaces

b GPIE-PLI
+-E8 Metwork adapters

T W P oK LT

Figure 2-14. GPIB-PCII/IIA That Is Working Properly

e e% ot i
+-17y Mouge i
-1 Mational Instruments GPIB Interfaces

¥ BEEaE
+-E8 Metwork adapters L

i . A
e d Eie OO0 B LTS

Figure 2-15. GPIB-PCII/IIA That Is Not Working Properly
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You can see if the problem is a resource conflict by looking at what
resources are conflicting, if the GPIB-PCII/IIA appears under the
National Instruments GPIB Interfaces icon. Double-click on the
GPIB-PCII/ITA name and click on the Resources tab, which provides
information about the hardware resources assigned to the
GPIB-PCII/ITA. The Conflicting Device List lists any conflicts. If
conflicts exist, use the Setting based on drop-down list and the
Change Setting button to select conflict-free resources for the
GPIB-PCII/TIA.

If you cannot find conflict-free resources for the GPIB-PCII/IIA, or if
no conflicts are listed, refer to the Troubleshooting Device Manager
Problems section of Appendix C, Troubleshooting and Common
Questions, to resolve the problem.

Assign an Interface Name

If you are using more than one interface, you must configure the GPIB
software to associate a logical name (GPIBO, GPIB1, and so on) with
each physical GPIB interface. Follow these steps:

1. Double-click on the first interface listed immediately below
National Instruments GPIB Interfaces.

2. Click on the GPIB Settings tab, which provides information about
the software configuration for the GPIB-PCII/IIA.

3. Use the Interface Name drop-down box to select a logical name
(GP1IBO, GPIB1, and so on) for the GPIB-PCII/ITA.

4. Repeat this process for each interface you need to configure.
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Figure 2-16 shows the GPIB Settings page for a GPIB-PCII/IIA.

GPIB-PCIl Properties EH
General GPIE Settings ]Driver ] Hesnurces]

w GFIE-FCI

Legacy Baze Addiess Ox2BE

Interface Name
=

GPIE Address

Frimary
0 -
Secaondary
MOME -

10 Timeout

10zec v

[¥ System Controller

Termination Methods

W Send EDI at end af YWrite
[~ Terminate Fiead on EOS
[ Set EOI with EOS onWrite
[~ EtitEOS Compare

ERET

Advanced...

ar. | Canicel

Figure 2-16. GPIB Settings Page for the GPIB-PCII/IIA

View or Modify Logical Device Templates (Optional)

If you want to examine or modify the logical device templates for the
GPIB software, select the National Instruments GPIB Interfaces icon
from the Device Manager page, and click on the Properties button.
Select the Device Templates tab to view the logical device templates,

as shown in Figure 2-17.

GPIB-PCII/IIA for Windows 98/95 2-18
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Figure 2-17. Device Templates Page for the Logical Device Templates
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Verify the Installation

This chapter describes how to verify the hardware and software
installation.

You can use the Diagnostic utility, installed with your GPIB software, to
test the hardware and software installation. The utility verifies that your
hardware and software are functioning properly and that the configuration
of your GPIB interfaces does not conflict with anything else in your system.

To run the utility, select the Diagnostic item under Start»Programs»
National Instruments GPIB.

When you have started the Diagnostic utility, test your GPIB interfaces by
clicking on the Test All button. If the Diagnostic is successful, it puts a
checkmark next to the interface and changes its status from untested to
passed. If the Diagnostic fails, it puts an X next to the interface, and
changes its status from untested to failed. Figure 3-1 shows the Diagnostic
utility after it has tested some GPIB interfaces.

33? Diagnostic [ 7]
GFIE Mare | Interface Type | Status |
WA GRIED GPIB-PCI paszed
B3 GRIE AT-GPIBATNT paszed
Wi GrIE2 PC/104-GFIB paszed

Sustem Detail:

GPIE Software for Windomws 95,/98, version 1.40

Figure 3-1. Diagnostic Utility after Testing
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You can get details on any tested GPIB interface by selecting the interface
and clicking on the Details button. For each failed GPIB interface, select it
and click on the Details button to get a description of the failure. Use that
information and the information in Appendix C, Troubleshooting and
Common Questions, to troubleshoot the problem. Troubleshooting
information is also available in the online help for the Diagnostic utility,
which you can access by clicking on the Help button.
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This chapter helps you get started with the GPIB software.

Getting Started with LabVIEW

LabVIEW is a fully-functional graphical programming environment used
to develop measurement and automation applications. LabVIEW features
comprehensive libraries for instrument control, data analysis, and data
presentation. If you already installed LabVIEW, you can use the LabVIEW
GPIB functions without any additional installation. To learn about the basic
concepts of GPIB communication, refer to the LabVIEW GPIB functions
chapter in the LabVIEW User Manual. To learn more about each GPIB
function, refer to the LabVIEW Function and VI Overview Manual and the
online help.

National Instruments provides LabVIEW instrument drivers to simplify
application development. Instrument drivers are high-level functions that
eliminate the need to learn the complex, low-level programming commands
for each instrument. For more information, refer to Chapter 7, Getting
Started with a LabVIEW Instrument Driver, in the LabVIEW User Manual.
If you want to write your own instrument driver, National Instruments
provides application notes that help you get started.

To use instrument drivers in LabVIEW, select the Instrument Wizard
from the Project menu.

For more information about National Instruments products, refer to our
web site at http://www.natinst.com/products/.

Getting Started with LabWindows/CVI

LabWindows/CVlI is an interactive C development environment used

to build measurement and automation applications. It provides
comprehensive libraries for instrument control, data analysis, and data
presentation. If you already installed LabWindows/CVI, you can use the
LabWindows/CVI GPIB Library without any additional installation. The
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Introduction to

LabWindows/CVI GPIB Library includes the functions documented in
your NI-488.2 or NI-488.2M reference manual, as well as several
additional functions, which are documented in the GPIB library chapter of
the LabWindows/CVI Standard Libraries Reference Manual. To help you
use the GPIB functions, LabWindows/CVI provides function panels for the
GPIB Library. To access the function panels, select GPIB/GPIB 488.2
from the Library menu of the Project or Source windows. For
information about using function panels, refer to the function panels
chapter in the LabWindows/CVI User Manual.

If you need to program a GPIB instrument, you might want to use an
instrument driver. An instrument driver is a set of high-level C functions
for controlling a specific instrument. The low-level steps to control the
instrument and read data are encapsulated in the high-level functions. You
can write an instrument driver yourself, or you can use one that is already
written. When you purchase LabWindows/CVI, you get free access to a
library of drivers for hundreds of instruments. For more information about
instrument drivers, refer to the project window chapter in the
LabWindows/CVI User Manual.

For more information about National Instruments products, please refer to
our web site at http://www.natinst.com/products/.

the Win32 Interactive Control Utility

GPIB-PCII/IIA for Windows 98/95

You can use the interactive control utility to enter NI-488 functions and
NI-488.2 routines interactively and see the values returned by the function
calls. You can use the utility to do the following:

e Verify GPIB communication with your device.

e Learn the NI-488 functions and NI-488.2 routines before you write
your application.

e  Become familiar with the commands of your device.
*  Receive data from your GPIB device.

e Troubleshoot problems with your application.

To run this utility, select the Win32 Interactive Control item under
Start»Programs»National Instruments GPIB. This utility includes
extensive online help, available by entering help at the : prompt.

For more information about the Win32 Interactive Control utility, refer to
the GPIB User Manual for Win32.
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Introduction to the NI Spy Utility

Included with the GPIB software is NI Spy, a Win32 utility that can be used
to monitor NI-488.2 calls made by Win32, Winl6, and DOS GPIB
applications. You can use NI Spy to do the following:

*  Capture information about NI-488 functions and NI-488.2 routines as
they are invoked by your GPIB applications.

» Display captured information, including, but not limited to, input and
output parameter values, I/O buffer contents, and return values.

e Save, restore, and print captured information.

To run NI Spy, select the NI Spy item under Start»Programs»National
Instruments GPIB. For more information about the NI Spy utility, refer to
Chapter 5, NI Spy Utility, in the GPIB User Manual for Win32, or use

its built-in, context-sensitive online help.

Running Existing DOS GPIB Applications

Note

With the GPIB software properly configured, you can run your existing
DOS GPIB applications along with your Win16 and Win32 applications.
No DOS device driver is required. In fact, make sure that no older version
of the GPIB DOS device driver is being loaded from your config.sys
file, a file located on the boot drive of your computer.

To determine if config. sys is loading an older GPIB DOS driver, look for the
line device=path\gpib.comin your config.sys file, where path refers to
the drive and directory where gpib . com is located. If that line appears, either
comment it out by typing REM at the beginning of the line, or delete it. If you
change the config. sys file, save it and restart your system.

To configure the GPIB software to run existing DOS GPIB applications,
first make sure that you have installed the GPIB software and your GPIB
hardware. Then complete the following steps:

1. Double-click on the System icon under Start»Settings»
Control Panel.

2. In the System Properties dialog box that appears, select the
Device Manager tab.

Click on the View devices by type button at the top of the page.

4. Click on the National Instruments GPIB Interfaces icon.
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5. Click on the Properties button to display the General property page
for the GPIB software.

6. Select the checkbox labeled Enable Support for DOS GPIB
Applications, and click on the OK button.

7. Restart your computer.

After you restart your computer, you can begin to run your existing DOS
GPIB applications.

General Programming Considerations

As you begin developing your Win32 GPIB application, remember the
following points:

e For your C/C++ application, you must include the GPIB header file,
decl-32.h, in your source code.

e The GPIB software is accessed through the 32-bit DLL,
gpib-32.d11, either by linking with one of the language interfaces
provided with the GPIB software, or by using direct DLL entry from
other programming environments.

e Several sample GPIB applications are included with the GPIB
software. Use these as a guide for your own application development.

For information about choosing a programming method, developing your
application, or compiling and linking, refer to the GPIB User Manual for
Win32. For detailed information about each NI-488 function and NI-488.2
routine, refer to the NI-488.2M Function Reference Manual for Win32

or the online help file, which you can access by selecting
Start»Programs»National Instruments GPIB»GPIB32 Help.
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Appendix

Uninstalling the
Hardware and Software

This appendix describes how to uninstall your GPIB-PCII/ITA and the
GPIB software.

Uninstalling the Hardware

Before you physically remove the GPIB-PCII/IIA hardware from your
system, you must remove the hardware information from the Windows
Device Manager. Complete the following steps to remove the hardware
information:

1. Select Start»Settings» Control Panel and double-click on the System
icon.

2. Inthe System Properties dialog box, select the Device Manager tab,
click on the View devices by type button, and double-click on the
National Instruments GPIB Interfaces icon.

3. Select the interface you want to remove from the National
Instruments GPIB Interfaces list, as shown in Figure A-1. Click
on the Remove button to remove the hardware information.

4. Click on the OK button, shut down Windows, turn off your system,
and physically remove the interface from your system.
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Figure A-1. Selecting an Interface to Remove

Uninstalling the Software

Before you uninstall the GPIB software, you should remove all GPIB
hardware information from the Windows Device Manager, as described in
the previous section. Complete the following steps to uninstall the GPIB
software:

1. Select Start»Settings»Control Panel and double-click on the
Add/Remove Programs icon. The dialog box shown in Figure A-2
lists the software available for removal.
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Figure A-2. Add/Remove Programs Properties Dialog Box

2. Select the GPIB software you want to remove and click on the
Add/Remove button. The uninstall program removes all folders,
programs, VxDs, DLLS, and registry entries associated with the GPIB
software.

If you have not physically removed your hardware, shut down Windows,
turn off your system, and remove the GPIB-PCII/ITA hardware.

The uninstall program removes only items that the GPIB setup program
installed. If you add anything to a directory that was created by the GPIB
setup program, the uninstall program does not delete that directory, because
the directory is not empty after the uninstallation. You will need to remove
any remaining components yourself.

If you want to reinstall the GPIB hardware and software, refer to Chapter 2,
Installation and Configuration.
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Appendix

Using the GPIB-PCII/IIA
in GPIB-PCIIA Mode

This appendix describes potential problems with using the GPIB-PCII/ITA
in GPIB-PCITIA mode and contains instructions for configuring the
GPIB-PCII/IIA in GPIB-PCIIA mode.

Problems Using the GPIB-PCII/IIA in GPIB-PCIIA Mode

The GPIB software allows you to install your GPIB-PCII/IIA board for use
in GPIB-PCIIA mode. The next section, Configure the GPIB-PCII/IIA in
GPIB-PCIIA Mode, describes the specific configuration settings for
GPIB-PCIIA mode. However, you should be aware of a potential problem
when using your board in GPIB-PCIIA mode under Windows.

The problem is with the Windows Device Manager. The Device Manager
does not reliably report base address conflicts involving the GPIB-PCII/ITA
in GPIB-PCIIA mode. Additionally, the Device Manager fails to display all
of the I/O addresses used by the GPIB-PCII/ITA in GPIB-PCIIA mode.
Therefore, a base address conflict may go unchecked when using your
board in GPIB-PCIIA mode. Base address conflicts can cause your
computer to hang or otherwise behave unreliably.

Therefore, it is safest to use the board only in GPIB-PCII mode, not in
GPIB-PCIIA mode. The Install the Hardware section of Chapter 2,
Installation and Configuration, explains how to install and configure your
GPIB-PCII/IIA for use in GPIB-PCII mode.
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Configure the GPIB-PCII/IIA in GPIB-PCIIA Mode

This section describes how to configure your GPIB-PCII/IIA board for use
in GPIB-PCIIA mode under Windows.

ii Caution  Electrostatic discharge can damage several components on the GPIB-PCII/IIA.
To avoid such damage in handling the board, touch the antistatic plastic package
to a metal part of your computer chassis before removing the board from the

package.

Verify GPIB-PCIIA Mode

Make sure that your GPIB-PCII/ITA is configured for use in GPIB-PCIIA
mode. Examine switch 9 in switch block U2. Verify that switch 9 is pressed
down on the side labeled PCIIA, as shown in Figure B-1.

7210
PCIl

1 U2 0

]

| I—
Iimm

7

[ = not used to select the GPIB-PC
or 7210/9914 mode

9914
PCIIA

Figure B-1. GPIB-PCIIA Mode Selection Setting

Verify 7210 Mode
The GPIB-PCII/ITA can emulate IEEE 488 interface boards that use
the 7210 GPIB Controller chip or the 9914 chip. Examine switch 8 in
switch block U2. Verify that switch 8 is pressed down on the side labeled
7210, as shown in Figure B-1.
Note The National Instruments GPIB software requires the board to be in 7210 mode.
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Configure the Hardware Resources

Configure the GPIB-PCII/IIA jumpers and switches to match the resources
assigned to it by Windows. If the resources assigned to it match the default
settings, you are ready to install the GPIB-PCII/IIA.

The default settings for GPIB-PCIIA mode are:
*  Input/Output Range: 2E1
e Interrupt Request: 7

e Direct Memory Access: 1

If the resources match the default settings, proceed to the Install the
GPIB-PCII/IIA section in Chapter 2, Installation and Configuration.

If the resources do not match the default settings, you must reconfigure the
jumpers and switches, as described in the next few sections, to match the
resources assigned to the GPIB-PCII/IIA by Windows. Figure 2-5,
GPIB-PCIU/IIA Parts Locator Diagram, in Chapter 2, Installation and
Configuration, shows the location of the configuration jumpers and
switches on the GPIB-PCII/IIA.

Configure Input/Output Range (GPIB-PCIIA Mode)

An Input/Output Range is a segment of address space reserved for the input
and output of a board. The base I/O address of an Input/Output Range is the
first position in the Input/Output Range used by the plug-in interface board.
By default, the GPIB-PCII/IIA is configured to use base I/O address

2E1 hex when in GPIB-PCIIA mode.

The GPIB-PCIIA base I/O address is set using switches 4 and 5 of the
switch block at U2. The four possible base I/O addresses are 2E1, 22E1,
42E1, and 62E1 hex. If you are installing more than one GPIB board, each
board must use a unique base I/O address.

Follow these steps to reconfigure the base I/O address of the
GPIB-PCII/TIA.

1. Locate the base I/O address switch at U2 on your GPIB-PCII/IIA
board. Refer to Figure 2-5, GPIB-PCII/IIA Parts Locator Diagram, in
Chapter 2, Installation and Configuration, to locate switch set U2.

2. Change the switch settings to configure the GPIB-PCII/IIA board to
match the base I/O address of the Input/Output Range assigned by
Windows.
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Figure B-2 shows the switch settings for the four possible base I/O
addresses and the address space used for each setting.
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r Push this side down (ON) for logic 0
1 U2 0 1 U2 0
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Figure B-2. Base I/0 Address Switch Settings for GPIB-PCIIA Mode
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Configure the Interrupt Request (GPIB-PCIIA Mode)

PC-compatible computers have a series of interrupt lines available to
devices. Devices use interrupts to get service from the CPU for
asynchronous events. Your GPIB hardware and software use interrupts to
get service from the CPU when necessary. By default, the GPIB-PCII/IIA
is configured to use interrupt request line 7.

Note If no interrupt lines are available for your GPIB hardware, the jumper and
switches must be moved to the disabled position, shown in Figure B-4.

To change the interrupt line in GPIB-PCIIA mode, you must set switches
10, 11, and 12 in switch set U2 to the new interrupt level setting in addition
to setting the interrupt jumpers.

Follow these steps to reconfigure the interrupt request line:

1. Find switch set U2 and the jumpers that set the interrupt request line.
The jumpers are located on the lower edge of your GPIB-PCII/ITA.
Refer to Figure 2-5, GPIB-PCII/IIA Parts Locator Diagram, in
Chapter 2, Installation and Configuration, to locate switch set U2.

2. Change the jumper settings to configure the GPIB-PCII/IIA to the new
interrupt request line. Figure B-3 shows the switch and jumper settings
for the default interrupt setting, IRQ7, and shows how the interrupt
setting was calculated from the switch positions.
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Push this side down (OFF) for logic 1
r Push this side down (ON) for logic 0
1 U2 0

440

PCII @:ﬁo PCIIA

[ = not used to select the interrupt line

Figure B-3. Default Interrupt Jumper Setting for GPIB-PCIIA Mode

Figure B-4 shows the switch and jumper settings for the five interrupt
lines other than the default, IRQ7, and for no interrupts.
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